
Welcome!

Thank you for purchasing our AZ-Delivery 64 LED Matrix Screen Module. On

the following pages,  you will  be introduced to how to use and set-up this

handy device.

Have fun! 
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Introduction

The 64 LED matrix screen is a screen with arrays of LEDs stacked in a matrix of

8x8 LEDs. There are 8 LEDs in one row and there are 8 rows  which creates a

matrix of  64 LEDs (64 pixels).  Each LED needs power and ground wires to

work. To avoid wiring all  64 LEDs one by one, the LEDs are connected into a

LED matrix, as shown on the following image:

 

Putting the LEDs into a matrix reduces the number of output pins to 16, which is

still too much, that is why on this module a driver chip is used. The 64 LED

matrix screen uses the driver chip called the MAX7219. The driver chip can be

connected serially with other driver chips in the Daisy chain like in the 4x64

LED Matrix screen from AZ-Delivery. It is possible to stack more, but you have to

use the external power supply for additional screens.
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https://www.az-delivery.de/products/4-x-64er-led-matrix-display?_pos=5&_sid=ca9acebdd&_ss=r
https://www.az-delivery.de/products/4-x-64er-led-matrix-display?_pos=5&_sid=ca9acebdd&_ss=r


The  MAX7219  chip  uses  the  SPI  interface  for  communication  with

microcontrollers.  The  SPI  stands  for  a  synchronous  serial  peripheral

communication  interface  and  it  is  used  for  short-distance  communication,

primarily in embedded systems. Synchronous means that the data is being sent

and received within a specific clock cycle and serial means that the data is sent

serially, bit by bit.

Specifications

» Operating voltage range: from +3.3V to +5V DC

» Color of LEDs: red

» Brightness control: digital and analog 

» Dimensions: 32 x 50 x 15mm [1.3 x 2 x 0.6in]

» 10MHz SPI interface 

» Display blanked on power-up 

» Drive common-cathode LED screens 
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The Pinout

The  64  LED  Matrix  screen  has  five  input  and  five  output  pins.  The  pinout

diagram is shown on the folowing image:

The driver chip uses SPI interface, where:

DIN > SPI MOSI – Master Output Slave Input

CS > SPI SS – Slave Select

CLK > SPI Clock – Clock signal
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The screens can be connected (stacked) serially, where the output pin of the

first screen is connected to the input pins of the second screen, and so on. This

can be seen on the following image: 

First screen > Second screen

VCC > VCC

GND > GND

DOUT > DIN

CS > CS

CLK > CLK

After  connecting  multiple  screens,  the  number  of  connected  devices  in  the

sketch example (or Python script example) should be updated accordingly. 
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How to set-up Arduino IDE

If  the Arduino IDE is not installed,  follow the link and download the installation

file for the operating system of choice.

For Windows users,  double click on  the downloaded  .exe file and follow  the

instructions in the installation window.
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https://www.arduino.cc/en/Main/Software


For Linux users, download a file with the extension .tar.xz,  which has to be

extracted.  When  it  is extracted,  go  to  the  extracted  directory  and  open  the

terminal in that directory.  Two .sh scripts  have to be executed, the first  called

arduino-linux-setup.sh and the second called install.sh.

To run the first script in the terminal, open the terminal in the extracted directory

and run the following command:

sh arduino-linux-setup.sh user_name

user_name -  is  the name of  a  superuser in the  Linux operating system.   A

password for the superuser  has to be entered when the command is started.

Wait for a few minutes for the script to complete everything.

The second script called install.sh script has to be used after installation of

the first script. Run the following command in the terminal (extracted directory):

sh install.sh

After the installation of these scripts, go to the All Apps, where the Arduino

IDE is installed.
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Almost all operating systems come with a text editor preinstalled (for example,

Windows comes with  Notepad,  Linux Ubuntu comes with  Gedit,  Linux

Raspbian comes with Leafpad, etc.). All of these text editors are perfectly fine

for the purpose of the eBook.

Next thing is to check if  your PC can detect  an Arduino board. Open freshly

installed Arduino IDE, and go to: 

Tools > Board > {your board name here} 

{your board name here} should be the Arduino/Genuino Uno, as it can

be seen on the following image:

The  port  to which  the  Arduino board is connected  has to be selected. Go to:

Tools > Port > {port name goes here} 

and when the Arduino board is connected to the USB port, the port name can be

seen in the drop-down menu on the previous image. 
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If the Arduino IDE is used on Windows, port names are as follows:

For Linux users, for example port name is /dev/ttyUSBx, where x represents

integer number between 0 and 9.
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How to set-up the Raspberry Pi and Python

For  the Raspberry  Pi,  first  the  operating  system  has  to  be  installed,  then

everything has to be set-up so that it can be used in the Headless mode. The

Headless mode enables remote connection to  the Raspberry  Pi,  without  the

need for a PC screen Monitor, mouse or keyboard. The only things that are used

in this mode are the Raspberry Pi itself, power supply and internet connection.

All of this is explained minutely in the free eBook:

Raspberry Pi Quick Startup Guide 

The Raspbian operating system comes with Python preinstalled.
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https://www.az-delivery.de/products/raspberry-pi-kostenfreies-e-book?ls=en


Connecting the screen with Uno

Connect the screen with the Uno as shown on the following connection diagram:

Module pin > Uno pin

VCC > 5V Red wire

GND > GND Black wire

DIN (MOSI) > D11 pin Green wire

CS (SS) > D10 pin Purple wire

CLK (SCK) > D13 pin Blue wire

NOTE: As there are different versions of the module, make sure to read the pin

designations before connecting it. Alternative pin names are included inside the

parentheses.
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Library for Arduino IDE

To use the screen with Uno, it is recommended to download the external library

for it. The library that is used in this eBook is called MD_MAX72XX. To install the

library, open the Arduino IDE and go to:

Tools > Manage Libraries

and when a new window appears, type MAX72XX into the search box. Install the

library called MD_MAX72XX made by majicDesigns, as shown on the following

image:

There are many versions of these screens. In order to detect which one is used,

the HardwareMapper sketch that comes with the library has to be executed. To

open the sketch, go to: 

File > Examples > MD_MAX72XX > MD_MAX72xx_HW_Mapper

and change the following line of the code:

#define SERIAL_SPEED 57600

into: #define SERIAL_SPEED 9600

- 13 -



Upload the sketch to the Uno and open the Serial Monitor (Tools > Serial

Monitor).  After that, follow the three-step instructions that  Uno sends to  the

Serial Monitor, as shown on the following image:
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To get the right result, make the orientation of the screen like on the connection

diagram.  The left side of  the screen is  the side where the input  pins of  the

screen are located. 

The result  hardware map is  FC16_HW, thus when using  AZ-Delivery 64 LED

matrix  screen module, in sketches from the library,  set  the  HARDWARE_TYPE

macro to this result value.
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Sketch example

#include <MD_MAX72xx.h >

#define HARDWARE_TYPE MD_MAX72XX::FC16_HW

#define MAX_DEVICES  1

#define CLK_PIN      13   // or SCK

#define DATA_PIN     11   // or MOSI

#define CS_PIN       10   // or SS

#define DELAYTIME    100  // in milliseconds

MD_MAX72XX mx = MD_MAX72XX(HARDWARE_TYPE, CS_PIN, MAX_DEVICES);

void scrollText(char *p) {

  uint8_t charWidth; 

  uint8_t cBuf[8];

  mx.clear();

  while (*p != '\0') {

    charWidth = mx.getChar(*p++, sizeof(cBuf) / sizeof(cBuf[0]), cBuf);

    for (uint8_t i=0; i<=charWidth; i++) { 

      mx.transform(MD_MAX72XX::TSL);

      if (i < charWidth) { 

        mx.setColumn(0, cBuf[i]); 

      }

      delay(DELAYTIME);

    }

  }

}

void rows() {

  mx.clear();

  for (uint8_t row=0; row<ROW_SIZE; row++) {

    mx.setRow(row, 0xff); 

    delay(2*DELAYTIME);

    mx.setRow(row, 0x00);

  }

}

- 16 -



void columns() {

  mx.clear();

  for (uint8_t col=0; col<mx.getColumnCount(); col++) {

    mx.setColumn(col, 0xff); 

    delay(DELAYTIME/MAX_DEVICES);

    mx.setColumn(col, 0x00);

  }

}

void intensity() {

  uint8_t row;

  mx.clear();

  for (int8_t i=0; i<=MAX_INTENSITY; i++) {

    mx.control(MD_MAX72XX::INTENSITY, i);

    mx.setRow(0, 0xff); 

    delay(DELAYTIME*10);

  }

  mx.control(MD_MAX72XX::INTENSITY, 8);

}
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void transformation() {

  uint8_t arrow[COL_SIZE] = {

    0b00001000,

    0b00011100,

    0b00111110,

    0b01111111,

    0b00011100,

    0b00011100,

    0b00111110,

    0b00000000 };

  MD_MAX72XX::transformType_t  t[] = {

    MD_MAX72XX::TSL, MD_MAX72XX::TSL, MD_MAX72XX::TSL, MD_MAX72XX::TSL,

    MD_MAX72XX::TSL, MD_MAX72XX::TSL, MD_MAX72XX::TSL, MD_MAX72XX::TSL,

    MD_MAX72XX::TSL, MD_MAX72XX::TSL, MD_MAX72XX::TSL, MD_MAX72XX::TSL,

    MD_MAX72XX::TSL, MD_MAX72XX::TSL, MD_MAX72XX::TSL, MD_MAX72XX::TSL,

    MD_MAX72XX::TFLR,

    MD_MAX72XX::TSR, MD_MAX72XX::TSR, MD_MAX72XX::TSR, MD_MAX72XX::TSR,

    MD_MAX72XX::TSR, MD_MAX72XX::TSR, MD_MAX72XX::TSR, MD_MAX72XX::TSR,

    MD_MAX72XX::TSR, MD_MAX72XX::TSR, MD_MAX72XX::TSR, MD_MAX72XX::TSR,

    MD_MAX72XX::TSR, MD_MAX72XX::TSR, MD_MAX72XX::TSR, MD_MAX72XX::TSR,

    MD_MAX72XX::TRC,

    MD_MAX72XX::TSD, MD_MAX72XX::TSD, MD_MAX72XX::TSD, MD_MAX72XX::TSD,

    MD_MAX72XX::TSD, MD_MAX72XX::TSD, MD_MAX72XX::TSD, MD_MAX72XX::TSD,

    MD_MAX72XX::TFUD,

    MD_MAX72XX::TSU, MD_MAX72XX::TSU, MD_MAX72XX::TSU, MD_MAX72XX::TSU,

    MD_MAX72XX::TSU, MD_MAX72XX::TSU, MD_MAX72XX::TSU, MD_MAX72XX::TSU,

    MD_MAX72XX::TINV,

    MD_MAX72XX::TRC, MD_MAX72XX::TRC, MD_MAX72XX::TRC, MD_MAX72XX::TRC,

    MD_MAX72XX::TINV };

  mx.clear();

  mx.control(MD_MAX72XX::UPDATE, MD_MAX72XX::OFF);

  for (uint8_t j=0; j<mx.getDeviceCount(); j++) {

    mx.setBuffer(((j+1)*COL_SIZE)-1, COL_SIZE, arrow);

  }
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  // one tab

  mx.control(MD_MAX72XX::UPDATE, MD_MAX72XX::ON);

  delay(DELAYTIME);

  mx.control(MD_MAX72XX::WRAPAROUND, MD_MAX72XX::ON);

  for (uint8_t i=0; i<(sizeof(t)/sizeof(t[0])); i++) {

    mx.transform(t[i]); 

    delay(DELAYTIME*4);

  }

  mx.control(MD_MAX72XX::WRAPAROUND, MD_MAX72XX::OFF);

}

void showCharset() {

  mx.clear();

  mx.update(MD_MAX72XX::OFF);

  for (uint16_t i=0; i<256; i++) {

    mx.clear(0);

    mx.setChar(COL_SIZE-1, i);

    if (MAX_DEVICES >= 3) {

      char hex[3];

      sprintf(hex, "%02X", i);

      mx.clear(1); 

      mx.setChar((2*COL_SIZE)-1, hex[1]);

      mx.clear(2); 

      mx.setChar((3*COL_SIZE)-1, hex[0]);

    }

    mx.update();

    delay(DELAYTIME*2);

  }

  mx.update(MD_MAX72XX::ON);

}
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void setup() { 

  mx.begin(); 

}

void loop() {

  scrollText("Graphics");

  rows();

  columns();

  intensity();

  transformation();

  showCharset();

  delay(3000);

}
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Th sketch starts  with  including the  MD_MAX72XX library,  then continues with

several definitions of macros. 

Then, specify which display is used, by setting HARDWARE_TYPE macro to  the

value FC16_HW (the result value from the HardwareMapper sketch).

After this, how many  screens are connected in the Daisy chain has by  set in

MAX_DEVICES macro. In this sketch it is set to the value “1“ (because only one

screen is used). If multiple LED matrix screens are connected in a Daisy chain,

change this value accordingly.

There are three more macros that define the SPI interface pins.

After that, the mx object is created, that represents the screen object that is

used throughout the whole sketch.

Next, several functions are created. 

The first function is called  scrollingText(),  which has one argument and

returns  no value.  The function is  used for  scrolling  text  on  the screen.  The

argument value is the scrolling text, a string value. 
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The  scrollingText() function  uses the  function  from  the  MD_MAX72XX

library called  setColumn().  The  setColumn() function turns  ON/OFF one

column  array  of  LEDs  on  the  screen.  The  rest  of  the  scrollingText()

function is the algorithm for the scrolling text effect. The function accepts string

p and converts the string into an array of unsigned integers which represents

characters of the text string. Then that array is displayed on the screen. At the

end of the function the delay time is set, which is the speed of the scrolling text.

The second function is called rows(), which has no arguments and returns no

value. The function  uses  a function  setRow() from the  MD_MAX72XX library.

The setRow() function  has two arguments.  The  irst  argument represents the

row  number, where  0 means  the first  row starting from the top.  The second

argument is an integer number in hexadecimal that represents 8 bit value for an

array of pixels (8 pixels in one row). In this case the value 0xFF (0b1111 1111) is

used, which turns ON all pixels of a specific row. For example, to turn only the

first two LEDs in the row use number 0x03.

Third function is called columns(), which accepts no arguments and returns no

value. It is almost as same as  rows() function,  but in this case  the  column

array of pixels  is turned ON. The function uses a function setColumn() from

the  MD_MAX72XX library.  The setColumn() function  is  the  same  as

setRow(), the difference is that setColumn()  function controls the columns.
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The fourth function is called intensity() which has no arguments and returns

no value. It is used to turn ON only the first row of the LEDs on the screen. The

function  uses  the control() function  from the  MD_MAX72XX library.  The

control() function has two arguments,  where the first  represents a property

of the mx object. In this case the property called MD_MAX72XX::INTENSITY is

controlled, thus the name of the function intensity. The second argument is

an integer number, that represents the level of intensity and its value is in the

range from 0 to 15. The default value is 8.

The fifth function is called transformation(), which has no arguments and

returns no value. It is used to animate bitmap images on the screen. The bitmap

image data is stored in the array of unsigned integers. This array contains  8

elements  and  every  element contains 8  digit  binary  number.  These  binary

numbers represent the rows of the screen, where binary value  0 represents  a

LED that is turned OFF and value 1 represents a LED that is turned ON. 
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Next, one more array called t is created, which contains enumerations used for

the  animations.  The  format  of  the enumeration  is  MD_MAX72XX::

{enumeration} where the enumeration is one of the following values: 

TSL - Shift Left for one pixel,

TSR - Shift Right for one pixel, 

TSU - Shift Up for one pixel, 

TSD - Shift Down for one pixel, 

TFLR - Flip Left to Right, 

TFUD - Flip Up to Down, 

TRC - Rotate Clockwise 90 degrees, 

TINV - Invert pixels (pixel in ON state changes in OFF state, and vice versa).

After this,  the setBuffer() function is used, which has three arguments and

returns no value. It is used to  set the data buffer of the MAX7219 driver  chip.

The first and the second arguments are the X and Y position of the image. The

X value starts at the top left corner of the screen and ends in the top right corner

of the screen; the Y value starts from the top left corner of the screen and ends

in bottom left corner of the screen. The third  argument represents the bitmap

image data.
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To display data, first disable updates of the screen, then set the data buffer and

after that enable the updates of the screen. This can be seen in the following

lines of code:

mx.control(MD_MAX72XX::UPDATE, MD_MAX72XX::OFF);

mx.control(MD_MAX72XX::WRAPAROUND, MD_MAX72XX::ON);

for (uint8_t i=0; i<(sizeof(t)/sizeof(t[0])); i++) {

  mx.transform(t[i]); delay(DELAYTIME*4);

}

mx.control(MD_MAX72XX::UPDATE, MD_MAX72XX::ON);

After this, the  displayed data  is animated.  It is done by using the  control()

function, WRAPAROUND property of the  mx object and  transform() function.

The for loop is used to loop through all of the enumerations from the t array.

The last function is called showCharsset() which has no argument and return

no value. It is used to show all UNICODE characters that can be used with LED

matrix  screen.  Here  the function  update() from the  MD_MAX72XX library is

used,  which  acts  like  control() function  with  property  UPDATE.  The

update() function  has one  argument,  which  value  can  be  one of  the  two

values: 

MD_MAX72XX::OFF and 

MD_MAX72XX::ON
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First,  the  argument  value  of  the  update() function  is  set  to

MD_MAX72XX::OFF,  which  disables  the  updates  of  the  data  buffer. Then

changes of the data buffer are made and saved; actually  the character that  is

displayed is changed. And then, the argument value of the update() function

is set to the value MD_MAX72XX::ON. The for loop is used to loop through all

of UNICODE characters (256 characters).

In the setup() function, the screen object is initialized with the following line of

code: mx.begin()

In the loop() function all functions that are created are executed, one by one.

To read more about these functions from the MD_MAX72XX library, visit a library

official documentation site.
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https://majicdesigns.github.io/MD_MAX72XX/class_m_d___m_a_x72_x_x.html


Connecting the screen with Raspberry Pi

Connect the screen with the Raspberry Pi as shown on the following connection

diagram:

Module pin > Raspberry Pi pin

VCC > 3V Red wire

GND > GND Black wire

DIN (MOSI) > GPIO10 [pin 19] Green wire

CS (SS) > GPIO8 [pin 24] Purple wire

CLK (SCK) > GPIO11 [pin 23] Blue wire
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Enabling the SPI Interface

In order to use the screen with a Raspberry Pi first, the SPI interface in the

Raspbian has to be enabled. To do so, go to: 

Applications Menu > Preferences > Raspberry Pi Configuration 

as shown on the following image:

Next, open the Interfaces tab, locate the SPI radio buttons and enable it, as

shown on the following image:
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Libraries and tools for Python

To use the module with the Raspberry Pi it is recommended to download an

external  library  for  it.  The  library  that  is  used  in  this  eBook  is  called

luma.led_matrix.  To  use  the  library  it  is  necessary  to  install  the

dependencies. To do so, open the terminal and run the following command:

sudo  apt  install  build-essential  python-dev  python-pip

libfreetype6-dev libjpeg-dev libopenjp2-7 libtiff5

Next, install the latest version of the luma.led_matrix library by running the

following command:

sudo -H pip3 install --upgrade luma.led_matrix
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Python script

import time

from luma.led_matrix.device import max7219

from luma.core.interface.serial import spi, noop

from luma.core.render import canvas

from luma.core.virtual import viewport

from luma.core.legacy import text, show_message

from luma.core.legacy.font  import proportional,  CP437_FONT,

TINY_FONT, SINCLAIR_FONT, LCD_FONT

def demo(n, block_orientation, rotate, inreverse):

    serial = spi(port=0, device=0, gpio=noop())

    device = max7219(serial, cascaded=n or 1,

        block_orientation=block_orientation, rotate=rotate or 0,

        blocks_arranged_in_reverse_order=inreverse)

    

    print('Created device')

    msg = 'MAX7219 LED Matrix Demo'

    print(msg)  

    show_message(device, msg, fill='white',

        font=proportional(CP437_FONT), scroll_delay=0.05) 

    time.sleep(2)
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    msg = 'Turn ON whole screen'

    print(msg)

    show_message(device, msg, fill='white',

        font=proportional(CP437_FONT), scroll_delay=0.05) 

    with canvas(device) as draw:

        for i in range(device.width):

            for j in range(device.height):

                draw.point((i, j), fill='white')

    time.sleep(1)

    msg = 'Brightness'

    print(msg)

    show_message(device, msg, fill='white')

    time.sleep(1)

    for _ in range(5):

        for intensity in range(16):

            with canvas(device) as draw:

                for i in range(device.width):

                    for j in range(device.height):

                        draw.point((i, j), fill='white')

            device.contrast(intensity * 16)

            time.sleep(0.2)

    device.contrast(0x80)

    time.sleep(1)
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    msg = 'Alternative font!'

    print(msg)

    show_message(device, msg, fill='white', font=SINCLAIR_FONT,

        scroll_delay=0.05)

    time.sleep(1)

    msg = 'Proportional font - chars are squeezed together!'

    print(msg) 

    show_message(device, msg, fill='white',

        font=proportional(SINCLAIR_FONT), scroll_delay=0.05)

    time.sleep(1)

    msg = 'Tiny font - the smallest font for LED matrix screen'

    print(msg)

    show_message(device, msg, fill='white',

        font=proportional(TINY_FONT), scroll_delay=0.05)

    time.sleep(1)

    msg = 'CP437 Characters'

    print(msg)

    show_message(device, msg)

    time.sleep(1)

    for x in range(256):

        with canvas(device) as draw:

            text(draw, (0, 0), chr(x), fill='white')

            time.sleep(0.5)
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print('[Press CTRL + C to end the script!]') 

try:

    while True: 

        demo(1, 0, 3, False)

        # the first argument: number of cascaded screens

        # the second argument: block orientation -> 0, 90, -90

        # the third argument: rotate -> 0=0, 1=90, 2=180, 3=270

        # the fourth argument: reverse order -> True/False

        time.sleep(1)

except KeyboardInterrupt:

    print('\nScript end!')

The code is based on the code from the following link.
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https://github.com/rm-hull/luma.led_matrix/blob/master/examples/matrix_demo.py


Save  the  script  by  the name  LEDmatrix.py.  To  run  the  script,  open  the

terminal into directory where the script is saved and run the following command:

python3 ledMatrix.py

The result should look like the output on the following image:

To end the scirpt, press CTRL + C on the keyboard.
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The script starts with the importing necessary libraries. 

Next,  the  function  called  demo() is  created,  which  has five  arguments  and

returns no value. It is used to run all example code containing functions from the

luma.led_matrix library. The arguments are:

» n - which represents the number of cascaded LED matrix screens

» block_orientation - which is used to correct orientation of  a single 

screen, its values are: 0, 90 and -90; the default is 0

» rotate - which rotates the content on the screen; its values are: 

0, 1, 2 and 3, which represent angles 0°, 90°, 180° and 270°, respectively;

default is 1

» reverse -  is a boolean value and when it is  set to the value True, the 

order of the screens is reverse; the default is False

Inside the demo() function,  the SPI communication object  called serial and

the  device object  called  device are created.  The  serial object  is used to

create the device object.
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To  display  a  scrolling  message  (horizontally)  on  the  screen  the

show_message() function  from the  luma.led_matrix library  is used. The

function has five arguments and returns no value. The last three arguments are

optional. The first argument is a device object; the second is the message; the

third is the fill argument; the fourth is the font argument; and the fifth is the

scroll_delay argument. 

The value of the  fill argument is the name of the color,  for example colors

like: white,  blue,  red, etc. If any other color other than  black is used  the

message  is displayed in red, because the color red is the color of LEDs on-

board the screen. If the value black is saved to the fill argument, the LEDs

on-board the screen are turned OFF.

The  font argument  is  used  for  setting  the  specific  font  of  the  text.  The

scroll_delay argument is used for changing the speed of scrolling text.

To change the brightness level, the  contrast() function is used, like in the

following line of code: device.contrast(number)

where the number is the level of brightness. There are 16 different brightness

level  values,  but  this  value has to  be a number  which when divided  by 16

returns integer number, because MAX7219 driver chip internal registers are set

in this manner.
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There are two ways of using fonts. First is to  save the font name to  the font

argument  of  the  show_message() function.  The  second  is  to  use the

proportional() function  to  set  the  value  of the  font argument.  The

proportional() function  has one argument, which value is the font name.

The  difference  between  these  two  ways  of  using  fonts  is  that  with  the

proportional() function font is displayed in proportion to the screen size.

To turn  ON/OFF specific LED on the screen use the  point() function. The

function  has  to be  used  with  the  draw object  from

luma.core.render.canvas library.  The  point() function  has two

arguments and returns no value. The first argument is a tuple of two elements,

where elements are  X and  Y position of the specific LED of the screen. The

second argument is the fill argument. 

To turn ON all LEDs of the screen use the following lines of code:

with canvas(device) as draw:

    for i in range(device.width):

        for j in range(device.height):

            draw.point((i, j), fill='white')

- 37 -



To display one specific character on the screen use the text() function. The

function has four arguments and returns no value. The first argument isthe draw

object from luma.core.render.canvas library. The second argument is the

tuple of two elements,  where elements are X and  Y position of the top left

corner of the character. The third argument is the character that  is displayed.

The fourth argument is the fill argument.

Ater the demo() function, the try-except block of code is created. To stop the

script CTRL + C on the keyboard. This is called keyboard interrupt. When the

keyboard interrupt happens,  the except block of code is  executed,  displaying

message Script end! in the terminal. 

In the try block of code the indefinite loop (while True:)  is created. Inside

the indefinite loop  the  demo() function  is executed  with the following line of

code:  demo(1, 0, 3, False)

Where the used arguments are: 

» 1 is the number of cascaded screens, in this case only one screen,

» 0 is block orientation, 

» 3 is rotation of content on the screen, where 3 = 270°, and 

» False is the normal order of the cascaded screens.
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Now it is the time to learn and make your own projects. You can do that with the

help of many example scripts and other tutorials, which  can be found on the

internet.

If you are looking for the high quality products for Arduino and Raspberry

Pi, AZ-Delivery Vertriebs GmbH is the right company to get them from. You

will  be  provided  with  numerous  application  examples,  full  installation

guides, eBooks, libraries and assistance from our technical experts.

https://az-delivery.de

Have Fun!

Impressum

https://az-delivery.de/pages/about-us
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